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Introduction 
Stair Builder is a collection of software tools that will help you design and model stairs in ArchiCAD. It 
provides better control while being less complex than other solutions. It is designed for people who find it 
awkward to design stairs within a settings dialog or wizard, and who prefer to design within the context of the 
virtual building. 

Some benefits of Stair Builder include: 

 Design in Context. Each flight, landing and balustrade is a separate element that can be 
stretched and re-shaped graphically. As a result you can directly reference other building 
elements (walls, slabs, etc.) as you design the stair. 

 No Calculations As flights and landings are added to the stair, the riser height of all flights is 
automatically re-calculated. If you stretch a flight, extra treads are added, linked flights and 
handrails will adjust to accommodate the change, and the riser height for the whole stair will be 
updated. The base elevation of each flight is also automatically calculated. You can adjust the 
total rise at any time.  

 Intuitive Design Designing a stair with the new Stair Builder is similar to drawing walls in 
ArchiCAD. Click to place, rotate and stretch each flight or landing into place. If the reference 
edge aligns with that of an existing stair, the new flight will automatically link to the stair. To 
place a railing along the edge of a stair, choose the Railing tool and click on the stair edge. 

 Powerful Graphic Editing Each flight and railing can be individually selected in the floor 
plan and edited graphically. Flights may be straight or curved, and each side of the flight can be 
straight, tapered or curved. If you edit a flight to which a railing is attached, the railing will 
automatically adjust to match the new shape of the flight. 

 Optimized 3D Model Stairs typically include many components – newels, handrails, treads 
and balusters. Each of these may be modelled using hundreds or thousands of polygons. Stair 
Builder optimizes the polygon count to provide clear curve definition with relatively few 
polygons. 

 2D Representation The 2D representation of the stair includes riser numbering, break lines, 
nosing lines and walking line. Above/below the break lines, you can choose how the remainder 
of the stair should be represented. The correct break line is automatically displayed in the 
home story and on stories above. A label is provided to display key information about the stair 
tool. 

 Extensible System The Stair Builder tool is an extensible system. Over time, more balustrade 
and flight types will be added. Each is a separate object, with its own special parametric 
options, so the tool itself will remain easy to use. If you have access to a GDL developer, you 
can create your own custom newels and balusters 

 

Stair Builder uses two element types to model stairs – Stair Components and Railings.  

 Stair Components are accessed from the Stair Tool in the ArchiCAD toolbar. Each stair 
component models a single flight or landing. Link any number of Stair Components together 
to form a complete stair. 

 The Railing tool is a new tool in the ArchiCAD toolbar. It allows you to model balustrades 
and handrails, and either place them independently like regular ArchiCAD objects, or snap 
them onto stair and slab edges. 

 
Stair Builder does not provide tools for modelling ramps or escalators. 
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Setup 
Before you can use the new Stair Builder tool, you must install the tool and update your ArchiCAD Work 
Environment. 

Installation 
Follow the instructions on the Cadimage Tools web site to download and run the installer. 

The installer will insert add-ons, data files, libraries 
and preset files into your ArchiCAD 12 folder. 
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You can download and install documentation 
separately. This will be added to the Documentation 
folder, and can be accessed from the ArchiCAD Help 
menu. 

 

 

 

 

 

 

 

 

 

 

 

Language 
Start ArchiCAD, and select the most appropriate language from the File > Set 
Cadimage Tools Language menu. This language will apply to all Cadimage 
Tools you have installed.  You will have to re-start ArchiCAD for the language to 
come into effect. 

 

Note that a particular tool may not have a 
translation for the selected language, in 
which case the tool will display in English. 

 

http://www.cadimagetools.com/
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Work Environment 
Start ArchiCAD and choose Options > Work Environment to bring up 
the Work Environment dialog. 

Use this dialog as described below to set preferences that will help you use 
Stair Builder effectively. 

Add the Handrail Tool to the ArchiCAD Toolbox 
 In the Options > Work Environment > 

Toolbox dialog, choose Railing from the 
Available Tools. 
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In the Toolbox Groups list, choose Design. 

Click the >> Add Selected >> button to add the Railing tool to the Design 

group in the toolbox. 

 

 

Click on the arrow icons to pull 
the Railing tool to a position 
directly below the Stair tool. 

 

 

 

 

 

Customize the Info Box 
In the Options > Work Environment > Info Box 
dialog, select the Stair Tool from the first list, then 
click to activate the new Flight Type and Reference 
Line items. 

 

 

 

 

 

 

 

 

 

 



  

 

Stair Builder 12 
Drag these items to a position near the start of the Info Box list. 

 

 

 

 

Keyboard Shortcuts 
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d shortcuts. 

ference line 
editing. 

 

tair component and railing. Whenever you open a 
ew project, the default style will be re-set for these tools. 

 

When you installed Stair Builder, items were added to the 
Cadimage menu. These menu items provide handy editing options. 
You will use these menu items frequently when designing stairs, so it 
makes sense to assign keyboar

 

Use the work environment to assign shortcut keys to the menu 
items. For example, you may want to use the shortcut key 
combination Alt-M to change the stair shape edit mode. This allows 
you to quickly change between shape editing and re

 

 

 

 

 

Default Settings 
In your ArchiCAD templates, set the default style for the s
n
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Design a Stair 

This section outlines various techniques you will use when designing stairs. 

The basic approach to designing a stair is to place, link and edit stair components. Other than selecting the 
CT Stair Component library part, everything described in this section can be done without opening the stair 
settings dialog. All the settings you need can be made via the Info Box or graphically using dynamic hotspots. 

 

 

Place & Link Stair Components 

Prepare to Place a Stair Component 
Double-Click on the Stair tool in the ArchiCAD toolbox, and select the CT Stair Component from 
the Stair Builder library. 

Before placing the stair, check that the following settings are correct. If you forget one or other 
of the settings, don’t worry. You can change the reference line, component type and stair width 
after placing the stair component. If you forget to choose the rotated diagonal geometry method 
or the correct edit mode, you can later stretch the flight or landing to size. 

 

 

Component Type 
In the Info Box, choose to place a flight, winders or landing. 

 

Reference Line 
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e line. 

Choose a reference line position from the Info Box. This mimics the reference line of the wall 
tool. When you place a stair, you will indicate the path of its reference line. The stair is 
placed centrally or to one side of the referenc

 

Stair Width 
In the Info Box, set the stair width. You can also set an offset from the reference line. 

 

Rotated Diagonal Geometry Method 
Choose the Rotated Diagonal geometry method from the Info Box. Note that you 
cannot stretch radial winders as you place them. 

 

Edit Mode 
Set the Stair Shape Edit Mode to Off. If you accidentally leave the 
edit mode on, you won’t be able to use the rotated diagonal geometry 
method. This is no problem, as you can still resize the stair 
component once it is placed. 
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Place a Stair Component 

Click to indicate a start point for the flight or landing, move the mouse cursor to indicate a direction, and 
finally click to indicate the end point. A flight or landing will appear, depending on the Info Box settings. 

At this point, the component will be linear, but now that it is in position you can change it to a curved flight, 
winders or landing. 

 

 

 

Link Stair Components 

Add extra flights and landings to the stair by placing stair components. Any new stair component that is 
placed at the end of the stair will be automatically linked into the stair structure. Use the Info Box settings to 
choose flights, landings and winders before you place them. 

You can link the start of a new flight to the end of an existing stair. You can also link the end of a new stair 
to the start of an existing stair. A list of special conditions for linking components is provided later in this 
document. 
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L-Shaped and U-Shaped Landings 

 

To form an L-shaped landing, first place a straight landing then add a second straight landing at an angle to 
the first.  

 

Add a third straight landing to create a U-shaped landing. 

Winders 

    

Link two flights at right angles to form a set of non-radial winders. 

 

To create radial winders, choose the Radial Winders type from the info box, bend the stair component and 
set the angle and radius. You can also set the minimum number of edges on each side of the winders. 
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Edit Stair Components 
Once a stair component has been placed into the project, you can adjust its settings at any time. Select the 
components you want to change, and adjust the settings as described below. All of the adjustments described 
in this section can be carried out within the context of the project – you do not need to open the stair settings 
dialog. 

Change the Component Type 
Use the Info Box to change the Component Type to Flight, Winders or Landing. 

Adjust the Width 
Adjust the Stair Width in the Info Box. 

Change the Reference Line 
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Choose a new Reference Line position in the Info Box. 

Adjust the Length 

 
Set the Stair Shape Edit Mode to Off. 

   

Select the stair component and stretch the hotspot at either end of the Reference Line to adjust its length. 
Any linked components will remain intact. 

If you adjust the length of a flight, the number of treads will be re-calculated. 

   

To change the position of the transition point between two linked, parallel stair components, select both 
components and adjust the dynamic hotspot at the intersection of the reference lines. 
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Create a Curved Stair Component 

 
 

When a stair component is first placed, it runs along a straight line. To make the component run along an arc, 
set the Stair Shape Edit Mode to Off and stretch the hotspot at the top end of the Reference Line to bend 
the stair. When you first bend the stair you can reference to a point in the project but you cannot directly 
control the angle and radius. You can adjust the radius and turn angle directly once the stair component has 
been curved. 

Another way to curve a stair is to open its Settings Dialog and set the angle and radius. This approach can 
be useful if you know the numeric values of the radius and angle. However you may find it quicker to adjust 
the values graphically, as this does not require opening the settings dialog. 

Set the Curve Angle 

 

You can change the angle through which a curved stair component turns. Set the Stair Shape Edit Mode to 
Off, then adjust the angle by moving the angle hotspot. Type in an exact value, or snap to a guideline or to a 
point in the project. 

You can also adjust the turn angle via the stair settings dialog. 
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Set the Curve Radius 

  

You can change the radius through of a curved stair component. Set the Stair Shape Edit Mode to Off and 
adjust the radius by moving either the centre hotspot or the radius hotspot. The radius hotspot can be found 
at the start of the stair component’s reference line. 

Type in an exact value, or snap to a reference line or to a point in the project. A negative value for the radius 
will make the stair curve in a clockwise direction. A positive value will make the stair curve in a counter-
clockwise direction. 

  

You can move either the center or the radius hotspot. If you want the start point of the stair component to 
remain stationary, adjust the center hotspot. If you want the center point to remain stationary, adjust the 
radius hotspot. 

 

Change the Shape 

 

 

Set the Stair Shape Edit Mode to On and a select a stair component. A bunch of new hotspots will appear. 
Use these hotspots to adjust the shape of the stair component. 
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A hotspot at each corner can be used to adjust the distance of that corner point from the walking line. 

  

A hotspot at the midpoint of each edge can be used to adjust the distance of that edge midpoint from the 
walking line, forming a curved or straight edge. 

 

Unlink Components 

 

If you rotate or drag a stair component so that its reference line no longer forms a continuous path with the 
other components in the stair, it will become unlinked. If you accidentally unlink a component, don’t worry – 
just undo the change you made to re-link the components. 

Any editing done using dynamic hotspots or the info box settings will automatically maintain the links 
between stair components. 

 

Change the Riser Height and Tread Depth 
You cannot adjust the preferred tread depth or riser height graphically. You must use the stair settings dialog 
to do this. 

 

Delete a Component 
If you want to remove a component from the stair, select that component and delete it. This may cause the 
stair to break into two linked sets of components. If this happens, simply drag one of the sets to re-link it. 
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Link Components 

You can link components that are already 
placed in the project. Just drag the 
component so that the reference lines meet 
and it will automatically link. 

     

 

 

 

 

 

 

 

 

Rotate Multiple Components 

 

When you rotate a stair component, you usually want to maintain the links of all the components of the stair. 
To do this, select all of the components that will be moved by the rotation and rotate them about the 
stationary end point. 

 

Adjust the Total Rise 

 

In the 3D window, stretch the top hotspots of the last flight up or down to set the total rise of the whole 
stair.  
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Create a Stepped Landing 
 To create a step part way along a landing, split the landing at that point 

then set the Stepped Landing checkbox to On in the Stair Settings 
dialog. This cannot be done graphically. 

 

 

 

 

 

 

Split a Flight or Landing 
 To add a flight in the middle of an existing stair, you can unlink 
flights, add the new flight, and re-link them. Alternatively you can 
use the Cadimage > Stair Builder > Split Stair tool to split selected 
flights. This tool splits a given stair component at a point along its 
reference line. 

To indicate the split point, you stretch a line across the stair. The 
point where this line intersects the reference line is the split point. 

To illustrate how the Split Stair tool works, consider the following example.  

Example 
We will create a stair consisting of a flight rising up to a corner landing, 
followed by a flight leading off the landing. 
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First draw two flights, ignoring the landings. Because they meet at an 
angle, the treads form non-radial 
winders. 

 

 

 

 

 

Now select the two flights, and select the Split Stair tool from the 
Cadimage > Stair Builder menu. You can save time here if you have 

this tool set up on a keyboard 
shortcut. 

C 

 

 

Click on either side of the reference lines of the stairs to indicate the 
two split points. 
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The stair is now split into four components, including two straight flights 
and two half-winders. The line we drew was diagonal, but this simply 
indicated a split point on the two reference lines. When the components 
split, they always meet at right angles to the walking line. 

 

 

 

F 
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Finally, select the winders and use the Info Box to change them 
into landings. 

 

 

 

 

 

 

Some Notes on Linking Stair Components 
 Two stair components will link together provided that their reference lines join. The reference 

lines must form a continuous path. 

 Straight flights and landings may meet at an angle to form corner landing or non-radial 
winders. 

 Curved flights and radial winders cannot have mitred ends. To link them to a stair, you must 
ensure the reference lines meet tangentially. 

 A stair component can not link to another component in a different storey. (Railings can link 
across stories however.) 
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Railings 

Railings can be snapped onto the edges of stairs and slabs, or placed independently like regular objects. This 
section describes how to place railings into your project. 

Use the railing settings dialog to design the appearance of the railing. This is outlined in a later section. 

 

Attach a Railing to a Complete Stair 

 

To place a railing along one side of an entire stair, select the railing tool from the ArchiCAD toolbox and 
click on an end point rather than an edge.  

 
If you had previously placed railings onto individual edges, these will remain intact. 
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Attach a Railing to a Single Stair Component 

 

 

Select the Railing tool from the ArchiCAD toolbox. Adjust the settings to model the railing, then click 
somewhere on the edge of a stair component. A railing will be placed along that edge. 

If no Railing tool appears in the toolbox, use the Work Environment to add the tool. 

Attach a Railing to a Slab Edge 

  

You can attach a railing to a slab edge. To do so, select the railing tool from the ArchiCAD toolbox and click 
on the edge. 

Place an Independent Railing 
To place an independent railing that is not connected to a slab or a stair component, select the Railing tool 
and click to place it like a regular object. 

Adjust the Length of a Railing 
All railings can be stretched via the reference line end hotspots. For independent railings, these are regular 
black hotspots. For railings attached to stairs or slabs, the hotspots are dynamic (diamond shaped). Select one 
of the hotspots, and pull it to extend or shorten the railing. 

Bend an Independent Railing 
At the midpoint of each independent railing is a dynamic hotspot. Moving this hotspot will cause the railing 
to bend along an arc through the end points and the mid point. 

Flip a Railing 
You can flip a railing to the other side of the reference line, provided it is not attached to a stair component. 
Use the railing settings dialog to do this. 

Delete a Railing 
Railings can be selected and deleted like regular ArchiCAD elements. 
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Link Railings 

Two railings will automatically link if the ends of their reference lines meet.  
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 The handrail and balustrade ends will automatically 
adjust to fit in with linked railings. 

 

 If you want the railings at the top of the stair to bend 
to the horizontal, place a short section of landing at 
the top. 

 Railings may be linked across storeys. 

 

Hotlinked Modules 
If you have a stair that repeats through multiple storeys, you could include it in a module then hotlink it into 
the project multiple times. 

If you use this approach, it is recommended that you do not include the railings with the module. Place these 
after you link the module into the project. 

This provides the best control over the handrail end types, and allows you to make changes to the railings on 
different storeys without breaking the hotlink. 
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Define a Style for the Stair 
If you want to apply the settings to the whole stair, you need to select all the stair components. Select one of 
the components, then use the Select Entire Stair/Railing menu item to select the entire stair. 
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 section. 

Now double-click on the Stair tool in the ArchiCAD toolbar to open 
the settings dialog. 

 

 

The CT Stair component has a settings dialog in 
which you can set dimensions and choose 
preferences. If you don’t know the exact 
dimensions of the stair, leave the Shape settings 
at their default values. If you like, you can set the 
total rise of the whole stair to match the vertical 
dimension the stair is intended to span. 
Available settings are described in this

 

 

Click OK once you have finished defining the 
style of the stair. 

 

 

 

 

Dimensions 
Click on the Dimensions item in the list to display the 
overall dimensions of the stair. Here you can set the 
total rise of the whole stair, set the length (or radius) 
and turn angle. 

Choose to Trim the Stair Base if this is the first flight 
of a stair. This tidies up the stringers below the first 
tread. 

If this is a landing followed by a landing, choose Split 
Level Landing to force a step in level. 

 

Structure 
First choose a basic Construction Method for the 
stair. You can choose treads only, concrete pre-cast 
stair, traditional timber stringer construction, steel 
stringers along the edges, or a central steel stringer or 
pair of stringers. 

 

Depending on your selection for the construction 
method, related settings will appear. 
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For concrete stringers, set the Stringer Depth and the Landing 
Thickness. You can Inset the concrete stringers to produce a tread 
overhang. 
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menu. 

 

 

 the top part, producing an ‘open’ 
ringer on that side of the stair. 

tting 
for a margin or kerb. 

ringer types, choose a 
Profile for the stringer, and 
set the dimensions. 

 

 

 

 

F 

 

 

For timber stringers, choose whether a stringer is 
included on the left, right or both sides of the stair. 
Timber stringers can also be used to model steel 
profiles. Choose the Stringer Profile from the 

 

Set the Stringer Depth and Thickness, and also a Margin or kerb 
that extends above the tread fronts. If you choose to Inset the 
stringers, the treads will cut away
st

 

 

 

 

Steel edge stringers have 
the same settings as the 
timber stringers. As these 
stringers run below the 
treads, there is no se

 

 

 

The final structure type is a central steel stringer. This type of stringer 
runs along the walking line. As with the other st
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ave the Space between Parallel Stringers setting at zero. To create two parallel 

s page is broken into two parts. Use the first part to select the number and style of the 
d

pen, closed or angled. 

rate riser piece. 

Set the Number of Treads for the selected stair 

You can choose rounded ends for the first tread. 

ight (see above) the going will be re-calculated. 

Changing the Riser Height will change the total rise of 

For a single stringer, le
stringers, set this value to be the separation between the stringers. 

Treads & Risers 
The Treads & Riser

 part to define the dimensions of the tread. 

Set the Riser Style to o

risers and the shape of the first tread. Use the secon

Number & Style 

Depending on the structure settings, this will have a 
different effect – for example concrete stairs do not 
include a sepa

component.  

 

 

Dimensions 
If you set the Preferred Going, the number of treads 
will be re-calculated. If you set the Number of Treads 
in the fl

Set the tread thickness, and the width of the front 
nosing. 

the stair. 

 

n this page you can also enable a Head Clearance 
lane. This is a plane that floats above the stair at a 
onstant height, to indicate the minimum clearance. 

ow the stair 
ill look in section when cut by the section line. 
eparate settings are available for the Structure 
tringers or concrete) and for the Treads. 

 

 

Model 
The Model page provides settings for pens, materials and fills used when constructing the 3D model. 

Pens & Materials 
Choose separate materials and contour pens for Treads 
and Structure (stringers or concrete). 

O
P
c

 

 

 

Cut Surfaces 
The pens and fills set on this page control h
w
S
(s
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Floor Plan Symbol 
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oor Plan Symbol is highly configurable. Aside from the basic outline and treads, there are 
ow the walking line is displayed, how th

p

utline and treads beyond the break lines, and 
for the reference line. Set the reference line pen to zero 

 invisible. 

Choose an arrow head and tail symbol for the walking 
line, set the head size, choose a pen and set the line type 
of the walking line. 

 riser numbers, including an offset from 

Choose an orientation for the numbering. The numbers 
can either follow the direction of the walking line, or 
remain vertical. 

Set the font, text size, style and pen for the numbers. 

, and set pen and line type for the 
break lines.  

Check the options to show a break line in either the 
home storey (the storey in which the stair was placed) or 

 

The stair’s Fl
settings for h e risers are numbered, what details are shown at 

laced. different drawing scales, and where break lines are 

Attributes 
Set a pen for the stair symbol background. If you 
choose a zero pen, the background fill will be 
transparent. 

Set line types and pens independently for hidden lines, 
the stair o

to make this line

The main contour of the stair is always drawn using a 
solid line. 

Walking Line 

 

 

 

 

 

Number the Risers 
Each riser on the stair can be numbered. Choose the 
location for the
the stair edge. 

 

 

Break Lines 
Choose how treads above and below the break line 
should be displayed

in an upper storey. 
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Scale Sensitivity 
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t to see full detail. For very small scale 

ine and the 

Select the drawing scales at which the symbol should 
transition between the three levels of detail. 

 

The final page of the Floor Plan Symbol settings 
provides control over what items are displayed at 
different drawing scales. For very large scale drawings, 
you will wan
drawings, the stair outline is sufficient. At intermediate 
drawing scales you can show just the outl
tread fronts. 
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Railing 

Double-click on the Railing tool in the ArchiCAD toolbar, and choose the CT Railing from the library. 

Dimensions 
On the first page of the settings dialog, set the heights 
for the balustrade and handrail. If these are to be offset 
from the edge of the stair or slab to which they are 
attached, set the offset values. 

 

 

 

 

 

Newels 
Newel posts can be included with the railing. A number of options are available to provide a high level of 
flexibility. 

Placement 
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rs. 

 

The first group of settings provides control over how 
the newels attach to the stairs. You can choose to 
attach the newels directly to the treads, to the stringers, 
or perpendicular to the rise angle. You can also choose 
to have no stringe

Set the preferred maximum spacing between newels. 

 

 

 

Newel Style 
Choose a newel style from the available options. Set the 
thickness and width of the newel. 

 

 

 

 

 

 

 

Choose the + option to type in the name of a custom newel not 
included with the regular library.
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Handrail Brackets 

The handrail is attached to the newel posts or directly 
to the wall, by means of brackets. Choose an option for 
the handrail bracket. You can choose not to include the 
brackets. 
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flight. 

Set the bracket drop and thickness. 

 

 

 

 

Choose the + option to type in the name of a custom bracket not 
included with the regular library.

 

Balustrade 

Balustrade Type 
Select a balustrade type from the list at the top of the 
settings dialog. Depending on which type you choose, 
different settings will appear. 

 

 

 

 

 

If you choose vertical balusters that attach to the treads, you can set 
the preferred spacing between the balusters. Also set a minimum 
number to attach to each tread, in case the tread depth becomes 
small, for example on the inside radius of a curved 

 

 

If you choose vertical balusters supported by a bottom rail, set the 
preferred spacing and the height of the bottom rail. 

 

 

 

 

If you choose parallel rails for your balustrade, set the preferred 
spacing as well as the rail width and thickness, and the height of the 
lowest rail. 
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If you choose a panel type balustrade, set the thickness and the 
distance the panel drops below the tread line. 

 

 

 

Balusters 
If you chose vertical balusters, this page provides 
settings for their appearance. Choose the baluster style, 
width and thickness. 

 

 

 

 

Select the + option to type in the name of a custom bracket not 
included with the regular library. 

 

Rails 
You can include a guardrail at the top of the balustrade. 
Choose the profile and dimensions of the rail. 
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option. 

 stair. You can also create a volute end. 

If you selected vertical balusters or a panel type 
balustrade, you can also choose a bottom rail. 

Two railings may join together, in which case the ends 
of the balustrade will automatically mitre to join the 
linked railing. If you would prefer a smooth curve 
instead of a mitre, choose the Smooth Corners 

Ends 
Free ends can be given a different style. You can 
choose a square cut end or bend the balustrade back to 
the edge of the
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Handrail 

Balustrade Type 
Select a handrail profile from the list at the top of the 
settings dialog. 
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the two railings are different, the handrails will not link. 

 the edge of the stair. You can 
lso create a volute end. 

 

 for each newel type is scripted into the newel 

 
the stair components to which the railings are attached. 

 

Two railings may join together, in which case the ends 
of the handrail will automatically mitre to join to the 
linked railing. If you would prefer a smooth curve 
instead of a mitre, choose the Smooth Corners 
option. 

Handrails will only mitre or bend if they intersect with 
a handrail on a linked railing. If the handrail heights on 

Ends 
Choose how the upper and lower ends of the handrail 
should behave, in cases where they do not link to an 
adjacent railing. You can choose a square cut end or 
bend the handrail back to
a

 

 

 

 

 

2D Symbol 
The railing’s Floor Plan Symbol has few options. 
Choose a background fill pen. The 2D Symbol 
displayed
objects. 

Break lines are automatically inserted to match those of
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Integrity Checking 

Stair Builder includes some tools to help you check the integrity of the stairs you model. This includes the 
stairs themselves, and how they fit into the building. 

Head Height Plane 

 

The head height plane provides a visual check that enough clearance has been left above the stairs. Displaying 
the head height line can serve to highlight design issues that might otherwise go un-noticed. 

 

To show the head height plane in 3D, 
Section and Elevation views, select the stair 
components and open the Stair Settings 
dialog.  
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In the Model > Pens & Materials page, 
turn the checkbox On and set the minimum 
head clearance height. 

 

 

 

 

 

Label the Stair 
Select one of the stair components, and open the 
Listing and Labelling tab. Click on the Label Stair 
checkbox. 
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Choose the CT Stair Label. This label displays the number of treads, the riser 
height and the total rise of the stair. 

 

 

 

 

Type a label string into the label settings dialog. The string can contain keywords, such as <RISERHEIGHT>, 
which are converted into numeric data when the label is placed into the project. 

 

A full list of available keywords is provided. Copy and paste these 
keywords into the label string. You can include any other text that you 
might like. 

Custom Components 
Stair Builder comes with a limited number of newels, balusters and handrail brackets. If you have a GDL 
development resource you can extend the available range by creating your own components. If you like, you 
can share these with other Stair Builder users by uploading them to the CadimageTools web site. 

Example objects are included in the library. To create a new custom component, open one of these example 
objects and save it under a new name then edit the scripts to create your own component.  

Sharing your Projects 
When you design a stair using Stair Builder, you might want to share the project with a colleague. You should 
ensure that your colleague has installed Stair Builder before he opens the project. Your colleague does not 
have to purchase or register the product. Unregistered products will work OK – your colleague will not be 
able to edit the stairs or create new stairs. 

If the project is accidentally opened and saved by someone who does not use Stair Builder, it is possible that 
the stairs may become unlinked. This is not a problem until you try to edit a stair. To reconstruct the stair, 
including all the links, select it and cut/copy the stair components and railings. Delete the original stair, then 
paste the clipboard contents back into the original location. The stair will be pasted back exactly as it was, and 
all links will be re-instated. 

If the stair includes custom newels, balusters or handrail bracketes, you will have to provide these library 
parts. 
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